
All our new releases now include on-line help files with hints and tips on how to
resolve problems you may confront when trying to run the game. The help
guide can be accessed from the Windows Start Bar in the same program
folder as your game’s shortcut. This gives you access to relevant support sites
via web links as well as a support program to help us diagnose problems that
may stop you enjoying your game. The support program also gives you the
option to send us your details via E-mail or Fax.

Glossary of Terms

If you do not understand any of the terms listed in this document you will find
a glossary in the menu bar of the on-line help file.

Use this reference card for information on installation, hardware and
software configuration and trouble shooting.



• Windows® 95/98

• 200 MHz Intel® Pentium® MMX processor

• 32 MB RAM

• 4MB video card.

• DirectX™ 6.1 compatible sound card with DirectSound™ support.

• DirectX™ 6.1 (supplied with CD)

• 300 MB free hard drive space

• 4x CD-ROM drive*

* Refers to a 4 speed CD-ROM drive 

• 300 MHz Intel Pentium II processor or faster

• 64 MB RAM 

• DirectX 6.1 compatible sound card with DirectSound™ support.

• 8MB 3D Hardware Accelerator Card with Direct3D support.See
Direct3D section of this Reference Card for supported cards.

• 16X CD-ROM drive

• Online features  requires TCP/IP internet connection at 28.8Kbps or
faster. Players are responsible for all applicable internet fees.
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The DirectDraw, DirectSound and Direct3D components of DirectX may
require updating your video, sound or 3D card drivers respectively, for proper
operation of these components. Using video, sound and 3D card drivers that
do not have DirectX 6.1 support will result in display, audio and 3D problems in
DirectX 6.1 applications. During the installation of DirectX 6.1, your video,
sound and 3D card drivers will be updated if required. The DirectX 6.1 files
included with Theme Park World includes drivers for most video, sound and 3D
cards from the major manufacturers of these peripherals. For new hardware,
for lesser-known brands of peripherals, or if you experience any problems
running the game, you may have to contact your manufacturer to obtain
drivers that have DirectX 6.1 support.

Installing DirectX 6.1

DirectX 6.1 is part of the Theme Park World installation procedure. If DirectX
6.1 (or later) is not detected on your computer, the installer asks you whether
or not you want to install it. Select yes to proceed.

After installing DirectX 6.1, check to see if your video, sound and 3D card
drivers have DirectX 6.1 support:

1. Click the Start button on your Windows 95/Windows 98 Taskbar.
Then click Run….

2. From the From the Run dialog box, type " dxdiag" (with quotation
marks) then click OK.

• The DirectX diagnostics program gives you information on your video,
sound and 3D card drivers. To check your video card drivers click on
the Display 1 tab, to check your sound card drivers click on the
Sound tab and to check your 3D card drivers click on the Display 2
tab. On each of these screens, the Drivers section tells you whether
your driver is certified by Microsoft as supporting DirectX 6.1. 

• If your driver is reported as ‘Certified: Yes’ your device has DirectX
6.1 support and should work properly in DirectX 6.1 applications.

Before you install any software, it is critical that your hard drive be in proper
working order. We recommend running ScanDisk and Disk Defragmenter.
ScanDisk searches your hard drive for any lost allocation units as well as any
cross-linked files and directories. Disk Defragmenter ensures that your data
is sorted properly. Failure to verify this may result in corrupt data.

1. First, run ScanDisk. To start ScanDisk, click on the START button
from the Taskbar. The Start menu opens.

2. From the Start menu, select RUN. Then, in the Run dialog box, type
scandisk and click OK.

Once the program starts, ensure that you have selected THOROUGH in the
Type of test section, make sure there is a check mark in the
AUTOMATICALLY FIX ERRORS box and select the hard drive you are
installing the game to (e.g., C:). Once everything is set up correctly, click
START to have the program scan the drive and correct any errors.

3. Next, run Disk Defragmenter. To start Disk Defragmenter, click on
the START button from the Taskbar. The Start menu opens.

4. From the Start menu, select RUN. Then, in the Run dialog box, type
DEFRAG and click OK. As with ScanDisk, select the drive you are
installing the game to and click OK.

™
Read This Section Completely Before Playing Theme Park™ World Or
Installing The DirectX Drivers.

DirectX is an Application Programming Interface that allows
Windows®95/Windows®98 based applications to have high-performance, real-
time access to your hardware. It also reduces the complexity of installing and
configuring your hardware. This makes the DirectX API well suited for
Windows 95/Windows 98 games. Theme Park World uses the DirectX 6.1 API
(the latest version of DirectX at the time of release) and includes DirectX 6.1
files which you can install.



Theme Park World uses QSound™ for 3D audio. We recommend that you
configure your speakers correctly before running the game. Your speakers
should be at the same height and level with your monitor. They should both
face directly forward and each be the same distance from the centre of your
monitor. This will create the optimal speaker layout for QSound™.

To uninstall Theme Park World go to the Theme Park World in the Start menu
and left-click on Uninstall Theme Park World to proceed.

Should this fail to work, left-click on the Start menu, select Settings and
then Control Panel. Run Add/Remove Programs and scroll down the list until
you see Theme Park World, select it and left-click on Add/Remove to uninstall.

If the uninstaller fails to completely remove Theme Park World (it may, for
example, not delete your Save folder), delete the folder to which you installed
the game. Thus, if you have used the default directories, double left-click on
My Computer, double left-click on the C: drive, double left-click on Program
Files, double left-click on the Bullfrog folder, right click on the Theme Park
World folder and select Delete. Click Yes to confirm. This will send the
remaining files to the Recycle Bin, which you will then need to empty.

™
Direct3D is a technology that provides improved graphical quality and
performance with dedicated 3D hardware cards. If you do not have a 3D
hardware device, you will not be able to run the Direct3D version of the game.

If you encounter any problems with the Direct3D version of Theme Park World,
first follow the checklist below:

• Make sure that you have a 3D device capable of running the Direct3D
version.

• If your driver is reported as ‘Certified: No’ your device may not have
full DirectX 6.1 support and may experience problems running DirectX
6.1 applications. If this is the case please consult the notes section at
the bottom of the DirectX Diagnostic Tool application. Windows 98
users may also consult the Troubleshoot button, accessed from the
More Help tab.

Important Note: During the installation of DirectX 6.1, the setup program
detects whether or not your drivers can be updated successfully. If the
driver being replaced has not been tested or replacing the driver is known to
cause problems, the setup program warns you accordingly. We recommend you
abide by these warnings.

™
Note: Theme Park World will only install and run on machines installed with
Windows 95, Windows 98 or any other compatible operating system.

1. Start your machine and wait for the Windows 95/Windows 98
operating system to load.

2. Place the Theme Park World CD in the CD drive.

3. Windows will automatically detect the CD and begin the installation.
Follow the on-screen instructions to install Theme Park World. If you
need to install DirectX 6.1, you can do this as part of the installation.
Theme Park World will then be ready to play.

4. The installation program creates a program group called Bullfrog and
adds it to your Start/Programs menu. Left-click on the Start button
on your Windows task bar. Under PROGRAMS/BULLFROG, select
Theme Park World and then select Theme Park World to play.

Note: Should Windows fail to recognise the CD and not run the installation
program, run Setup.exe from the root of the CD.



FAQ’s

Problem: I have two 3D cards in my machine - how do I select between them?

Solution: To change between 3D Cards, go to Theme Park World Lobby, press
escape, choose options and toggle the Video Card: Primary/Secondary option.

Alternatively, you can alter the setting in the Options menu when you are in
your park, but you will have to restart the game for the changes to take
effect. Your park is saved when you exit, so when you re-enter you can
continue where you left off.

Problem: The 3D version seems slower than the software version.

Solution: This can be true for certain 3D hardware cards, or it could be true
simply because you have a slow 3D card in a very fast machine. If this is the
case, we recommend using the software version

Please follow this procedure for solving the problems with your 3D Hardware
Card:

• First, if you have internet access, download the latest drivers from
your 3D Hardware Card manufacturer’s website. If not, contact the
manufacturer through their technical support hotline. Remember, this
is the 3D Hardware Card manufacturer and not the 3D chipset
manufacturer.

• If this still doesn’t work, download the latest reference drivers from
the website of your hardware card’s 3D chipset manufacturer. 

• Make sure that your 3D device drivers are the latest releases and
completely up to date. You can get the latest drivers direct from the
manufacturer of the device, either through their technical support or
from their website. Many problems are caused by old and out of date
drivers. You can find your manufacturer’s technical support telephone
numbers from the manuals you received either with your computer or
with the 3D card. You can also contact your computer supplier if you
cannot find these numbers.

To change between the hardware and software versions, go to Theme Park
World Lobby, press escape, choose Options and toggle the 3D Card
Rendering/Software Rendering option.

Alternatively, you can change from Hardware to Software within the Options
menu when you are in your park. You will have to restart the game for the
changes to take effect. Your park is saved when you exit, so when you re-
enter you can continue where you left off.

General

Most problems in the Direct3D version are a result of having out of date
drivers for your 3D card. If you have a problem, try updating your display
drivers first. You can usually obtain the latest drivers from your 3D card
vendor’s web page or by contacting their technical support directly. If this
doesn’t solve the issue, read on.

Note: You can still run the software version of the game instead if the
Direct3D version does not work on your machine.



ATI™ Rage  II™ ATI XPERT@WORK™
ATI XPERT@PLAY™
ATI XPERT 98™
All-in-Wonder Pro™
etc.

Rage 128™ Rage Fury™
Rage Magnum™
XPERT 128™

Intel™ i740™ ASUS V2740™
Diamond Stealth II G460™
Real3D Starfighter™
STB System Lightspeed 
Hercules Terminator 
2x/I™
etc.

Matrox™ G200™ Millenium G200™
Mystique G200™
Marvel G200™

G400™

nVidia™ Riva 128™/ Riva 128 ZX™ STB Velocity 128™
ASUS 3DexPlorer 3000™
Canopus Total3D 128V™
Canopus WitchDoctor™
Diamond Viper V330™
etc.

To find out whether or not Theme Park World supports your 3D Hardware Card,
you must know the make of 3D chip that the card is built from. The most
popular of these include ATI, 3DFX Voodoo 2/3, nVidia, Intel and Matrox.

There are many 3D Hardware Cards and chipsets on the market, and many
more will be produced in the future. Therefore a comprehensive list of
supported cards and chipsets is very hard to compile. If your card is not
mentioned in the lists, but it supports the Direct3D standard, then it is likely
to work. Simply try running the game following the normal installation
instructions, after installing the latest drivers for your card. Remember that
even if your card is not supported directly, you can still run the game: go to
the Theme Park World front-end menu, choose Options and toggle the 3D
Card Rendering/Software Rendering option.

Supported Cards

Chip Maker Chipset Name(s) 3D Cards

3DFX Interactive© Voodoo™ 2 Creative Blaster 
Voodoo 2
Orchid Righteous 3D ®II
Diamond Monster 3D™ II, 
etc.

Voodoo™3 STB Voodoo3 2000/3000/ 
3500™
etc.

Voodoo Banshee™ Diamond Monster Fusion™
Wicked 3D Vengence™
etc.

3Dlabs® Permedia™ 2 Creative Graphics Blaster 
Exxtreme™
Diamond FireGL 1000 Pro™
etc.

Permedia™ 3



Be sure that you are using the latest 32-bit native Windows 95/Windows 98
driver to control your CD-ROM drive. You can configure these drivers from
Start>Settings>Control Panel>System>Device Manager>CDROM>Properties.

Do not use a DOS-based 16-bit driver (loaded in CONFIG.SYS) to control your
CD-ROM. Performance may be significantly reduced.

Choppy or stuttering video or audio problems while running in Windows
95/Windows 98 may be corrected by adjusting the CD-ROM read-ahead
caching.

To adjust the read-ahead cache:

At the Windows 95/Windows 98 desktop, right-click the My Computer icon,
then choose Properties from the pop-up menu.

Click the Performance tab then click File System….

3. Click the CD-ROM tab, then click on the Optimise access pattern
for: box and choose QUAD-SPEED OR HIGHER

4. Move the Supplementary cache size slider to SMALL, then click
Apply.

Note: Moving the slider to LARGE will not improve Theme Park World video
performance, as it may actually hinder performance by reserving memory that
would otherwise be available for the game.

Your Windows desktop resolution can be set to any size or colour palette
above 16 colours in order to run Theme Park World. If you do experience
problems, it is recommended that you change the colour palette to, at least,
High Colour (16 bit).

Riva TNT™ Canopus SPECTRA 2500™
Diamond Viper V550™
STB Velocity 4400™

Riva TNT 2™ etc.

S3® Inc Savage3D™ Hercules Terminator 
Beast™
Nitro 3200™

Savage4™ etc.

If you have any problems installing or using Theme Park World, we want to help.

Please make sure you have read thoroughly the System Requirements and
Installing Theme Park World sections earlier in this booklet.

If you have followed the directions and are still experiencing problems
installing or operating the game, below are some guides that might help solve
the problem.

Receive`File not found` Error Messages When Installing or Running the
Game

Make sure that the CD is in the CD drive. The CD must be in the drive to
install and run the game.



• If you are using Soundfonts (AWE32 and AWE64),  and you
experience problems you may need to install some new drivers. First,
go to the Control Panel by selecting Start>Settings>Control Panel.
Double left-click on Add-Remove Programs and scroll down the list
of programs until you see Soundfont Management System. Select
this and left-click on Add/Remove. Confirm that you want to remove
the Soundfont Management System and wait for it to be deleted.

• Now, explore the root of the Theme Park World CD. Double left-click on
Redist and double left-click on Soundfont. Double left-click on
setup.exe inside this folder. Follow the instructions on screen to
install the new Soundfont Management System.

• If you are still experiencing problems with Soundfonts, you may
already have a Soundfont bank loaded onto your soundcard. You can
clear the soundcard memory by re-setting your machine.
Alternatively, if available, use the Awe 64 Gold Software Suites clear
memory function.

• If you are running another application that uses the soundcard, Theme
Park World may experience audio break-up or loss. Close all applications
that require sound before running the game.

• If the game cannot find Qmixer.dll, you can re-copy the file from the
root of the Theme Park World CD to where you installed Theme Park
World ,e.g. c:\Program Files\Bullfrog\Theme Park World.

Note: You need to select “Show all files”, in the View>Folder Options>View
screen.

Theme Park World requires 32 MB RAM and Virtual Memory Enabled. We advise
that you let Windows 95/ Windows 98 manage the amount of virtual memory
automatically (the default setting), and that you have at least 70 MB free
hard disk space after installation.

To do this, right-click on your Windows desktop and left-click on Properties.
Left-click on the Settings tab and left-click on the Colors dialog box. Left-
click on High Color (16bit) .

General Video Card Information

• During DirectX installation, the DirectX setup program attempts to
install a display driver that supports DirectDraw for your video card.
If your video card driver does not support DirectDraw, the DirectX
setup program replaces your existing video card driver. In some
cases, this may disable manufacturer specific utilities for your video
card. If you want to keep these utilities functional, you may have to
obtain the latest drivers with DirectDraw support directly from the
manufacturer of your video card.

• If your video card driver already has DirectDraw support, but is not
yet Certified by Microsoft®, you are asked if you want to replace
your current driver. In most cases, you do not want to replace your
existing driver as this may disable Manufacturer specific utilities for
your video card. If you do have video-related problems using your
manufacturer’s uncertified DirectDraw drivers, you may solve these
problems by reinstalling DirectX and replacing your current video
driver with a DirectX 6.1 video driver.

Theme Park World uses QSound to run its 3D audio. If you have any problems
with audio, please follow the directions below:

Installed sound card but there is no sound

• Make sure that your speakers are plugged in and turned on. Also,
check that the volume is turned up and not muted.

General Sound Card Information

• QSound uses the DirectSound drivers for your soundcard hardware.
Make sure that you have the most recent drivers for your soundcard
installed on your machine. You can install these drivers during the
Theme Park World installation (when the installer asks you whether you
want to install DirectX). You can obtain the most recent drivers
direct from the hardware manufacturer.



(If you are still having problems identifying your systems components see
the “How to obtain the information required”) section below.

If you cannot find the above information then you will need to consult your
supplier or manufacturer. 

How to Obtain The Information Required

Windows® 95/Windows® 98 Users

1. Right click on My Computer.

2. Left click on Properties.

3. The General information screen will detail how much RAM you have
and the CPU make (e.g. Intel/Cyrix).

4. Now click on Device Manager.

5. Click on the `+` symbol on the relevant devices i.e.

• CD-ROM 

• Display adapters

• Sound, video & game controllers.

• Network Adapters

You will then be able to see the manufacturer of these devices.

1. The CPU speed can be seen if you reset your PC and look towards the
top left corner of the screen. You should see a CPU clock speed (e.g.
166 MHz). This is the processor speed that you need.

2. Double left click on “My Computer” then click square symbol to
maximise screen.

3. Left click on your hard drive (C:\) and this will list how much free
disk space you have and the total amount of disk space you have on
the system. Now close all windows down.]

With this information you will be able to configure your machine correctly. If
you have obtained this information, and are still having problems, then
Electronic Arts has a Customer Service Department that is ready to help you
with any problems you may encounter with the game.

If, after thoroughly reviewing ALL the procedures, you are still having a
problem running this software, please read the following section.

Today’s PCs run with millions of different hardware and software
combinations.

The following information MUST be obtained from the manufacturer of your
PC or from within your enclosed documentation BEFORE calling our technical
support line:

(N.B. The following information can be obtained direct from your PC
manufacturer)

1. The error message displayed when the problem occurred (if any).

2. A listing of your machine spec, including:

CPU speed and make (e.g. Pentium III 500Mhz)

Amount of RAM (e.g. 128MB RAM)

CD-ROM speed and make (e.g. Creative 48X)

Sound card make (e.g. SoundBlaster)

Video card makes (e.g. Intel I740)

Network card (If any) (e.g. 3COM)

Hard disk size and amount of free space (e.g. 12GB)

DirectX™ driver versions (e.g.  4.11.01.0441). See the section headed 
”What is DirectX™ and why do I need it to run the game ?”

Joystick and Game card (If any)

3D Accelerator card (If any) (e.g. Voodoo 3000 AGP 16MB RAM)



telephone number a description of the problem you are getting and a complete
listing of you machine specifications as specified at the start of the Customer
Services section.

Electronic Arts Customer Service, PO BOX 181, Chertsey, Surrey,
England SL3 8XU.

Or fax us, including a complete report of your systems specification, on:

0870 2413231 

When contacting us by fax or letter, please include a daytime telephone
number whenever possible, so we can contact you if necessary.

Game hints and cheats

To acquire hints and cheats for the majority of our new releases you will need
to call the Electronic Arts Hintline (open 24 hours a day)

09067 53 22 53
Note: This is a premium charge line (calls cost 75p per minute). Please obtain
permission to call this number from the person who pays the phone bill, before
you call.

Having Problems obtaining one of our games ?

If you have difficulties finding any of our EA products in your local stockist,
and you have access to the Internet then please visit our web shop at

http://shop.ea-europe.com
where you can order any EA product. If you do not have Internet access, or if
you cannot find the game you’re looking for, please call Customer Services, on
0870 2432435, and our staff will be happy to help with your enquiry.  When
you call, please choose the Direct Sales option from the menu to ensure your
call is routed correctly.

Please note that Customer Services can only take orders where payment is
made with a major credit. Debit cards, Cheques and Postal Orders cannot be
accepted.

How to reach us On-Line

Internet e-mail: uk-support@ea.com

Electronic Arts: http://www.ea.com

Bullfrog Productions: http://www.bullfrog.co.uk

Website: http://www.ea.com

Electronic Arts offers 24-hour support via our on-line services. Here you will
find extensive product support and other information. In addition, this site
provides answers to Frequently Asked Questions (FAQ’s) plus patches,
updates and demos. If you still cannot find an answer to your query, please E-
mail us at uk-support@ea.com. You will receive an automated reply within
minutes; giving details of all the games you can request troubleshooting
information on, as well as a number of standard help guides and information
sheets. If this does not help, you can contact a representative for a personal
reply.

If you have any queries on warranty replacements or user-damaged disks or
manuals, please e-mail us on uk-warranty@ea.com
Please note that this is only for warranty and NOT technical queries.

Electronic Arts have a staff of Customer Services Representatives ready to
help you with any technical problems you may have with our games.

Customer Services have manned lines open from 9am-6pm Monday to Thursday
& 9am-4:30pm Friday, and can be reached on the following number:

0870 2432435 

Note: This is a National call rate line charged at 6p per minute at peak times
and 2.6p per minute off peak. (These charges are correct at the time of
publication) In order to improve our customer service, we will log your details
into a secure database.  When you are connected to a representative, you will
be asked for several details, including your surname and date of birth.  This
information will not be shared with any external companies, or used for
marketing purposes without your consent.

You can also talk to one of our Customer Services Representatives, who will be
pleased to help you with your questions. 

Automated services are available 24 hours a day, including Faxback and
recorded messages. However, please ensure you have followed all normal
trouble shooting steps and have all relevant information to hand before you
call.

Alternatively, you may write to us at the following address, including a daytime



Notice

ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS IN THIS PRODUCT
DESCRIBED IN THIS MANUAL AT ANY TIME AND WITHOUT NOTICE. THIS MANUAL, AND
THE SOFTWARE DESCRIBED IN THIS MANUAL, IS UNDER COPYRIGHT. ALL RIGHTS ARE
RESERVED. NO PART OF THIS MANUAL OR THE DESCRIBED SOFTWARE MAY BE COPIED,
REPRODUCED, TRANSLATED OR REDUCED TO ANY ELECTRONIC MEDIUM OR MACHINE-
READABLE FORM WITHOUT THE PRIOR WRITTEN CONSENT OF ELECTRONIC ARTS LIMITED,
PO BOX 181, CHERTSEY, SURREY, KT16 0YL, ENGLAND. ELECTRONIC ARTS MAKES NO
WARRANTIES, CONDITIONS OR REPRESENTATIONS EXPRESS OR IMPLIED, WITH RESPECT
TO THIS MANUAL, ITS QUALITY, MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
PURPOSE. THIS MANUAL IS PROVIDED “AS IS”. ELECTRONIC ARTS MAKES CERTAIN LIMITED
WARRANTIES WITH RESPECT TO THE SOFTWARE AND THE MEDIA FOR THE SOFTWARE. IN
NO EVENT SHALL ELECTRONIC ARTS BE LIABLE FOR ANY SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES. THESE TERMS AND CONDITIONS DO NOT AFFECT OR
PREJUDICE THE STATUTORY RIGHTS OF A PURCHASER IN ANY CASE WHERE A PURCHASER
IS A CONSUMER ACQUIRING GOODS OTHERWISE THAN IN THE COURSE OF A BUSINESS.

Limited Warranty

Electronic Arts warrants to the original purchaser of this computer software product
that the recording media on which the software programs are recorded will be free
from defects in materials and workmanship for 12 months from the date of purchase.
During such period defective media will be replaced if the original product is returned
to Electronic Arts at the address at the rear of this document, together with a dated
proof of purchase, a statement describing the defects, the faulty media and your
return address.

This warranty is in addition to, and does not affect your statutory rights in any way.

This warranty does not apply to the software program themselves, which are provided
“as is”, nor does it apply to media which has been subject to misuse, damage or
excessive wear.

Returns After Warranty.

Electronic Arts will replace user-damaged media, current stocks allowing, if the original
media is returned with a Eurocheque or postal order for £7.50 per CD, payable to
Electronic Arts Ltd.

Please remember to include full details of the defect, your name, address and, where
possible, a daytime telephone number where we can contact you.

Electronic Arts Customer Warranty, P.O. Box 181, Chertsey, Surrey, KT16 0YL, UK.
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